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Tutorial C 
 

How to Use IFTDSS to Prepare a 
Prescribed Burn Plan 

 

Using the Red Bull Prescribed Burn Plan as an example  
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Overview 

This tutorial covers the following topics: 

 Setting up a project in IFTDSS. 

 Creating and filling in the burn plan template. 

 Establishing burn objectives and environmental thresholds. 

 Using the Prescribed Burn Planning workflow to perform the following tasks: 

• Describe what modules can be used for specific burn plan elements. 

• Model minimum and maximum fire behavior and effects inside the burn unit. 

• Model worst-case fire behavior and effects outside the burn unit. 

• Download the inputs and output variables needed for the burn plan document. 

 Generating the burn plan as a Microsoft Word document and customizing the plan. 

• Filling in the appendices with maps and modeling data. 

 

Note:  Before continuing with this 
tutorial, we recommend that you 
review Tutorial B:  How to use hazard 
analysis tools in the IFTDSS for 
prescribed fire planning. 

 

../05-Hazard-Analysis/HA_Tutorial_Rx_Planning.pdf
../05-Hazard-Analysis/HA_Tutorial_Rx_Planning.pdf
../05-Hazard-Analysis/HA_Tutorial_Rx_Planning.pdf
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Introduction 
The Prescribed Burn Plan 

 is a site-specific implementation document  

 is a legal document that provides the Agency 
Administration the information needed to 
approve the plan  

 provides the Prescribed Fire Burn Boss with all 
the information needed to implement the 
prescribed fire 

Prescribed fire projects must be implemented 
in compliance with the written plan 

(U.S. Department of Agriculture and U.S. Department of 
the Interior [2008] Interagency Prescribed Fire Planning 
and Implementation Procedures Guide, p. 19.  Citations 
for this guide will be in this form:  USDA and U.S. DOI, 
2008.) 

Note:  The main reference glossary for the Interagency 
Prescribed Fire Planning and Implementation Procedures 
Guide (IPFRG) is the National Wildfire Coordinating Group 
(NWCG) Glossary. 

http://www.nwcg.gov/pms/RxFire/rxfireguide.pdf
http://www.nwcg.gov/pms/RxFire/rxfireguide.pdf
http://www.nwcg.gov/pms/RxFire/rxfireguide.pdf
http://www.nwcg.gov/pms/pubs/glossary/index.htm
http://www.nwcg.gov/pms/pubs/glossary/index.htm
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Introduction 

IFTDSS also contains tools for preparing 
and generating a burn plan document 
that is based on the guidelines in the  

 Interagency Prescribed Fire Planning and 
Implementation Procedures Reference 
Guide (USDA and U.S. DOI, 2008)  

 RX-341 Prescribed Fire Plan Preparation 
course.  In this tutorial, we follow along 
with the Red Bull Prescribed Burn Plan 
example given in that course. 

Important:  Microsoft Word 2007 or later, or 
Word 2003 with the Microsoft Office 
Compatibility Pack, is required to open the 
burn plan document.  You can download the 
compatibility pack at Microsoft.com. 

Using the tools in IFTDSS, you can 

 Model fire behavior and fire effects for 
different fuel models and environmental 
scenarios. 

 Create a prescribed burn plan; as part of 
your planning process, you can save a 
Word file from IFTDSS that has a number 
of elements filled in from your model 
runs. 

The tools provided under the IFTDSS 
prescribed burn planning workflow aid 
fuels treatment planners and prescribed 
fire planners in assessing fire behavior 
and effects for varying fuel and 
environmental conditions. 

http://www.microsoft.com/download/en/details.aspx?id=3
http://www.microsoft.com/download/en/details.aspx?id=3
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Tutorial Objectives 

This tutorial 

 provides users with the skills and tools needed 
to prepare a prescribed burn plan in 
accordance with agency policy and guidelines. 

 is based on the 21 required elements of a 
prescribed burn plan identified in the 
Interagency Prescribed Fire Planning and 
Implementation Procedures Reference Guide 
(USDA and U.S. DOI, 2008) . 

 describes what is minimally acceptable for 
prescribed fire planning and implementation. 

 uses the example burn plan in the RX-341 
Prescribed Fire Plan Preparation course (Red 
Bull Prescribed Burn Plan). 

Note:  Agencies may choose to provide more 
restrictive standards and policy direction, but 
must adhere to the minimums described in 
the IPFRG (USDA and U.S. DOI, 2008, p. 7). 

 



6 of 67 

Begin by creating a new project. 

 After creating a new project, you will see the Create 
new run page. 

 The next step is to acquire LANDFIRE data, so we are 
going to navigate away from this page. 

Access the Data tab. 

Getting Started 
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Getting Started 

Now, we will acquire data 
from LANDFIRE. 

Choose Acquire Data from LANDFIRE. 
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Selecting a Data Set Area 

Navigate to your desired 
location by using one of these 
three options: 

1. Using the navigation tools 
located in the top left 
portion of the map. 

2. Using the mouse.  Click and 
drag to move; double-click 
to zoom in. 

3. Entering coordinates. 

Tip:  For this example, the 
coordinates are 

• North: 44.0575942 

• East: -99.4283515 

• South: 44.0528583 

• West: -99.4345037 

B 

A 

C 

A 

B 

C 
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Selecting a Data Set Area 

Choose Acquire to import LANDFIRE 
data. 

Tip:  Select a large project area.  By 
creating a large project area, you can view 
landscape data and model fire behavior 
and effects inside and outside the burn 
unit. 

Maximum area:  Acquisition of LANDFIRE 
data is limited to 250,000 acres.  
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After acquiring the 
LANDFIRE data, click the 
Projects tab. 

Choose the Project you 
are working in. 

In this example, we are 
working in the Red Bull 
project that we previously 
set up. 

Next, acquire data for 
use in this project. 

Defining the Project Area of Interest 
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Defining the Project Area of Interest 

There are three ways to define the project area of interest. In this 
example, we use the Copy an existing data set method. 

Select the Red Bull Unit data set. 

Choose Next. 

Note: Once you select a data set, the 
Project Area cannot be changed. 

To change the Project Area, you must 
create a new project. 
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At the bottom of the Project 
Summary page, under the 
Project Data section, select 
Edit. 

The Data Studio window 
appears. 

Reviewing Spatial Landscape Data 

Note:  Pop-up blockers must 
be disabled in order to open 
Data Studio.  See Known 
Issues in the help for other 
notes on Data Studio. 

Now that the project area is defined, review the landscape data for the project area. 

../01-Front-Matter/KnownIssues.htm
../01-Front-Matter/KnownIssues.htm
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Reviewing Spatial Landscape Data 

Now you can review your spatial landscape data using the map in Data Studio.  In this 
example, you can see the project area classified by fuel model. 
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Editing Spatial Landscape Data 

On the upper toolbar, click the Edit tool          and select the desired grid cell. 

An Edit Data toolbox appears.  From here, you can edit all input values.  In this example, 
FM3: Tall Grass is selected from the Fuel Model drop-down list. 

After reviewing the data, several of the grid cells are labeled as FM8:  Compact Timber 
Litter.  These cells should be changed to FM3:  Tall Grass. 



15 of 67 

Editing Spatial Landscape Data 

There are also cells labeled as FM8: Compact Timber Litter, which should be labeled as 
FM2: Timber Grass and Understory or FM9: Hardwood Litter.  These cells are edited one 
at a time. 

You can also edit the following landscape layers:  canopy base height, canopy height, 
canopy bulk density, canopy coverage, elevation, aspect, and slope. 

BEFORE AFTER 
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Editing Spatial Landscape Data 
With Data Studio, you can also save 
the map as an image       . 

In the example, we showed how grid cells can 
be edited one by one.  There is also an 
Advanced Editing          tool that you can use to  
edit in query format so you can change 
multiple cells at once. 

Note:  When you are done editing, choose 
Save          and close the Data Studio window. 
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Creating a New Run 

Now that we have 
defined, reviewed, and 
edited our area of 
interest, we will create 
a new run. 

Choose Create New 
Run. 
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Creating a Burn Plan 

Tip:  Open two windows (or tabs) in the browser.  This 
way you can view and fill out the burn plan template in 
one window while conducting modeling in another 
window. 

Window (or tab) 1:  Burn plan template 

Window (or tab) 2:  Fire behavior and effects modeling 

To choose the type of run you would like to create, click 
the following links: 

Prescribed Burn Planning 

Create a burn plan document 

By IFTDSS Workflows 

The next step in creating a run is to choose the type of 
run you would like to create.  In this tutorial, we are 
creating a burn plan, so that is the type we will choose. 
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Table of Contents and Navigation 
 

This is the Table of 
Contents for the burn 
plan. 

You can navigate from 
element to element by 
using any of the following: 

1. The bar at the top of 
the page. 

2. The links located in 
the Table of Contents. 

3. The Next button. 

A 

C 

B 

A 

B 

C 
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Elements Overview 

The 21 Elements in a burn plan range in complexity (see the Element Complexity table). 

 

 

 

 

 

 
Some Elements cannot be completed until after the burn plan is finished (Elements 1, 2, 
3, and 10). 

IFTDSS contains tools for modeling fire behavior and fire effects; these tools are useful 
in obtaining information needed to address Elements 3, 4, 5, 7, 15, 16, 17, and 19. 

The following pages step through each Element. 

Recreated from the RX-341 Prescribed Fire Plan 
Preparation course, page 0.9. 

Element Complexity  

Element Ranking Burn Plan Element 

Easy complexity 1, 2, 10, 12, 21 

Low complexity 4, 6, 8, 14, 19, 20 

Medium complexity 5, 9, 11, 13, 18 

High complexity 2, 7, 15, 16, 17 



21 of 67 

Modules and Burn Plan Elements 

The matrix on this page shows which modules can be used for specific burn plan elements.  Most 
of the modules can be used for multiple elements.  Refer back to this matrix when you are using 
the prescribed burn planning tools and when you are making a burn plan. 
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Element 3: Complexity Analysis Summary ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 4: Description of Prescribed Fire Area ● ● ●

Element 5: Objectives ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 7: Prescription ● ● ○ ● ● ○ ○ ● ○ ● ●

Element 15: Ignition Plan ○

Element 16: Holding Plan ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 17: Contingency Plan ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 19: Smoke Management and Air Quality ● ●

Appendicies: Appendix A. Maps (Vicinity and Project) ● ●

aAs implemented in BehavePlus                                                  
bAs implemented in FCCS                                                               
cAs implemented in FlamMap                                                      
dAs implemented in FOFEM                                                           
eAs implemented in Consume                                                           

○ = facilitate in decision making                                                       

● = outputs needed for burn plan

Data and 

Mapping 

Tools

Fire Behavior Fire Effects Fire Containment
Probability 

of Ignition

M
O

D
U

LE
S/

TO
O

LS
 

ELEMENTS 

CATEGORIES 
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Signature Page  
(Element 1) 

Navigate to Element 1: Signature Page. 

The following information must be included on the signature 
page: 

1. Administrative unit name. 

2. Prescribed fire name. 

3. At a minimum, three dated signatures are required: 

• Prescribed Burn Plan Preparer 

• Technical Reviewer 

• Agency Administrator 

4. Final determined complexity rating. 

(USDA and U.S. DOI, 2008, p. 19) 

Important:  You can only save your work by choosing 
Next – this will save your progress. 
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Go/No-Go Checklists                               
(Element 2, Part 1 and Part 2) 

Part 1 – Agency Administration 

This checklist evaluates whether 
compliance requirements, prescribed fire 
plan elements, and internal and external 
notification(s) have been completed. 

Expresses the Agency Administrator’s 
intent to implement the Prescribed Fire 
Plan. 

(USDA and U.S. DOI, 2008, p. 19) 

Part 2 – Prescribed Fire 

Prior to all ignition operations, the 
Prescribed Fire Burn Boss will complete 
and sign this checklist. 

For each day of active ignition on a 
prescribed fire, a separate daily Go/No-
Go Checklist is required. 

Note:  The online burn plan template 
Go/No-Go checkbox lists cannot be used 
until after the burn plan is completed.  
Once the burn plan is generated, a 
Yes/No table replaces the checkbox list.  
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Complexity Analysis Summary 
(Element 3 and Appendix C) 

The purpose of the complexity rating 
process is to provide 

 assignment of a complexity rating of high, 
moderate, or low to the prescribed fire 

 a relative ranking as to the overall 
complexity of a specific prescribed fire 
project for management and 
implementation personnel  

 a process that can be used to identify 
Prescribed Fire Plan elements or 
characteristics that may pose special 
problems or concerns 

The Prescribed Fire Complexity Rating 
Guide was developed to assist personnel  
in determining a relative complexity of  
any single prescribed fire project 

The Summary Complexity Rating Rationale 

 will clearly justify the summary rating for 
prescribed fire organization and Prescribed Fire 
Burn Boss level 

 must identify those risks from the Complexity 
Analysis (Appendix C) that are rated high and 
cannot be mitigated and will provide a 
discussion of the risks associated 

 

(USDA and U.S. DOI, 2008, p. 20) 

http://www.nwcg.gov/pms/RxFire/complexity_analysis.pdf
http://www.nwcg.gov/pms/RxFire/complexity_analysis.pdf


25 of 67 

Description of the Prescribed Fire Area 
(Element 4 ) 

Physical Description 
 
The physical description provides information on the 
various physical aspects of the area where the 
prescribed burn is to be made. 

Location 

Narrative description of the location of the prescribed fire 
project, including a legal description, UTM and/or 
latitude/longitude, county, and state. 

Size 

Area, in acres, of the prescribed fire project, with a 
breakdown by prescribed fire unit and/or ownership if 
applicable. 

Topography 

Identies the upper and lower range of elevation, slopes 
(max/min/avg), and aspect(s). 

Project Boundary 

Defines the area where fire will be ignited and may be 
allowed to burn. 

Describes the physical, natural, and/or human made 
boundaries . 

Defines through maps; may include narratives . 

(USDA and U.S. DOI, 2008, pp. 20 and 21) 
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Description of the Prescribed Fire Area 
(Element 4 ) 

Vegetation/Fuels Description 

• Describe  the structure and composition of 
the vegetation type(s) and fuel 
characteristics. 

• Describe the percent of the unit 
composed of each vegetation type  and 
the corresponding fuel model(s). 

• Identify conditions (fuels, slope, aspect) in 
and adjacent to boundaries that may be a 
potential threat for escaped fire. 

Description of Unique Features  

• List and discuss special features, hazards, 
regulations, issues, constraints, etc. 

(USDA and U.S. DOI, 2008, p. 21) 
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It is important to establish burn 
objectives prior to fire behavior and 
effects modeling. 

Describe in clear, concise statements the 
specific measureable resource and fire 
objectives for your prescribed fire. 

Objectives must be measurable and 
quantifiable so prescription elements can 
be developed to meet those objectives 
and the success of the project can be 
determined following implementation. 

(USDA and U.S. DOI, 2008, p. 21) 

Red Bull Objectives 

In the Red Bull example, the objectives 
fall under two categories: 

• Resource Objectives 

Reduce the risk of future wildland urban 
interface fire from destroying 
homes/structures or other special features. 

• Prescribed Fire Objectives 

Burn at least 90% of the target area. 

Reduce the fine dead herbaceous fuel 
loading by 90% or more immediately 
following the completion of ignition. 

Resource and Prescribed Fire Objectives (Element 5) 
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Resource and Prescribed Fire Objectives (Element 5) 

Tip:  Click and drag 
the corner of the text 
box to modify the 
size of the text box. 

Here, the objectives from the Red Bull example have been entered in IFTDSS. 
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Identify the funding source(s) 
and estimated cost(s) of the 
prescribed fire. 

As shown here, some 
prescribed burns are conducted 
in phases; Element 6 can be 
itemized by phase if desired. 

(USDA and U.S. DOI, 2008, p. 21) 

Funding 
(Element 6) 
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Environmental Prescription            
(Element 7) 

Now that the burn objectives are 
established, we can create a range of 
environmental parameters that will be 
used when modeling potential fire 
behavior and effects. 

Each module has its own set of unique 
environmental input parameters. 

The next step is to navigate to Element 
7: Prescription, in the “Create a burn 
plan document” template. 

The burn plan environmental 
prescription will describe 

– a range of low to high limits for the 
environmental (weather, topography, 
fuels, etc.) parameters 

– a set of “worst-case” parameters in 
case of escape 

• Hottest, driest, windiest prescription 
limits 

• Most extreme environmental 
conditions (slope, aspect) 

(USDA and U.S. DOI, 2008, p. 21 and 22) 

 

Prescription is defined as “the measurable criteria that define a range of conditions 
during which a prescribed fire may be ignited and held as a prescribed fire.” 
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Environmental Prescription              
(Element 7) 

Once you navigate to Element 7: 
Prescription, fill in the 
Environmental Prescription. 

Now that the objectives 
(Element 5) and Environmental 
Prescription are established, we 
can use the Prescribed Burn 
Planning Workflow to model 
potential fire behavior and 
effects. 

Note:  Burning when all environmental 
prescription variables are at or near the 
prescription extremes will likely exceed 
desired prescribed fire behavior 
characteristics, and should be 
considered out of the range of 
conditions that meet the prescription 
(USDA and U.S. DOI, 2008, p. 22). 
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Element 3: Complexity Analysis Summary ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 4: Description of Prescribed Fire Area ● ● ●

Element 5: Objectives ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 7: Prescription ● ● ○ ● ● ○ ○ ● ○ ● ●

Element 15: Ignition Plan ○

Element 16: Holding Plan ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 17: Contingency Plan ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

Element 19: Smoke Management and Air Quality ● ●

Appendicies: Appendix A. Maps (Vicinity and Project) ● ●

aAs implemented in BehavePlus                                                  
bAs implemented in FCCS                                                               
cAs implemented in FlamMap                                                      
dAs implemented in FOFEM                                                           
eAs implemented in Consume                                                           

○ = facilitate in decision making                                                       

● = outputs needed for burn plan

Data and 

Mapping 

Tools

Fire Behavior Fire Effects Fire Containment
Probability 

of Ignition

There are several tools to choose from for fire behavior and effects modeling.   

In this example, we use Surface fire behaviora and Crown scorch heighta for our Fire 
Behavior Prescription (Element 7). 

Fire Behavior Prescription                                                 
(Element 7) 
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To start modeling potential 
fire behavior and effects, 
right-click on your Project link, 
Red Bull, and select Open a 
New Tab. 

Modeling Potential Fire Behavior and Effects 
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Create a New Run 

Choose Create New Run. 

Now we are on the 
Project Summary page. 
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Workflows:  Prescribed Burn Planning 

This workflow contains tools needed to model potential fire behavior 
and effects for the burn plan document. 

These tools also facilitate in the decision making for ignition, holding, 
and contingency plans, as well as smoke management and air quality. 

Prescribed Burn Planning Workflow 

Follow the steps shown in the images, and choose Calculate 
surface fire behavior (as implemented in BehavePlus). 
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Modeling Surface Fire Behavior 
(Element 7) 

Tip:  By choosing three simulations, you 
can model the minimum, maximum, and 
worst-case fire behavior in one run.  
IFTDSS supports a maximum of 25 
simulations. 

Tip:  Give runs descriptive names so you 
can more readily identify them later. 
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Modeling Surface Fire Behavior                                                 
(Element 7) 

Tip:  Run surface fire behavior or 
surface fire behavior for FCCS 
fuelbeds before running the other 
modules.   

Some of the inputs for other 
modules are outputs from Surface 
fire behavior (e.g., the output 
flame length from surface fire 
behavior is needed as an input for 
crown scorch height). 

Insert data from your 
Environmental Prescription 
(Element 7) into the 
surface fire behavior 
inputs. 



38 of 67 

Modeling Surface Fire Behavior                                            
(Element 7) 

Surface fire behavior reports 
head, backing, and flanking fire 
parameters. 

Using the Export to Table link, 
you can modify the outputs table 
into Microsoft Excel format. 

When you generate the burn 
plan (see page 67), IFTDSS 
creates the burn plan as a 
Microsoft Word document.  You 
can paste the modified table into 
the appendices of the Word 
document. 

The output flame 
length from surface 
fire behavior is 
needed as an input 
for crown scorch 
height. 
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Creating a New Run 

Choose the Red Bull Project link to 
return to the Project Summary page. 

Then choose Create New Run. 

Next, we want to predict crown scorch height. 
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For this step, make the choices 
shown to the left. 

Prescribed Burn Planning Workflow 

Then choose Predict crown scorch height (as implemented in 
BehavePlus). 
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Modeling Crown Scorch Height 

Tip:  Give runs descriptive names 
so you can more readily identify 
them later. 

Tip:  By choosing nine simulations, 
you can model the minimum, 
maximum, and worst-case fire 
behavior for head, flanking, and 
backing fires in one run. 
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Modeling Crown Scorch Height                                            
(Element 7) 

Tip:  In this example, we used 
the flame length outputs from 
the surface fire behavior (as 
implemented in BehavePlus) run 
as the inputs of the crown scorch 
height (as implemented in 
BehavePlus) run. 

Export the crown scorch height 
results to Microsoft Excel 
format by using the Export 
Table (CSV) link. 

Navigate to the Red Bull Burn 
Plan tab and fill in the Fire 
Behavior prescription for 
Element 7. 

Continue modeling fire 
behavior and effects using the 
previous steps. 
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Fire Behavior Prescription                            
(Element 7) 

1. Navigate to Element 7: 
Prescription. 

2. Fill in the Fire Behavior 
Prescription. 

If the burn unit is dominated 
by more than one fuel model, 
create multiple runs with 
descriptive names. 

There are multiple Fire 
Behavior Prescriptions in the 
burn plan for extra fuel 
models. 

3. Important:  Choose Next 
(at the bottom of the page) 
to save your progress. 

(Shown above is just the top section of this page.) 
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Modeling Considerations 

Models are based on simplified assumptions, such as uniform fuel and 
steady-state fire spread. 

Rather than basing your burn plan prescription solely on modeling, the 
USDA and U.S. DOI (2008) allows for the use of empirical evidence (historical 
evidence or researched data) and judgment.  These can be used to identify 
or corroborate prescriptions.  

Weaknesses in modeling can be overridden, but must be justified with 
empirical evidence and/or verified actual fire behavior. 

(USDA and U.S. DOI, 2008, p. 22) 
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Scheduling; Pre-burn Considerations and Weather; Briefing 
(Elements 8, 9, and 10) 

Scheduling 

Identify the general ignition time frame(s) 
(i.e., time of day, duration of ignition) or 
season(s) and note any dates on which the 
project may not be conducted. 

Briefing 

All assigned personnel must be briefed at the 
beginning of each operational period to 
ensure personnel safety. 

Prescribed fire objectives and operations 
must be clearly defined and understood. 

The briefing checklist should list briefing 
topics only, not re-state what is listed in the 
Prescribed Fire Plan for that element. 

The Prescribed Fire Burn Boss is to ensure 
that any new personnel arriving at the 
prescribed fire site receives a briefing prior to 
assignment. 

Pre-burn Considerations and Weather 

Describe the onsite and offsite actions 
to be conducted and considerations to 
be addressed prior to implementation.  
Describe any fuel sampling and weather 
data that may need to be obtained. 

The plan will include a list of 
organizations and individuals that are 
notified prior to ignition, with contact 
information for each organization and 
individual. 

 (USDA and U.S. DOI, 2008, pp. 22-23) 
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Organization and Equipment; Communication; Safety and Medical 
(Elements 11, 12, and 13) 

Organization and Equipment 

Specify the minimum required 
implementation organization needed to meet 
the capabilities (line production rates, etc.) by 
position, equipment, and the supplies 
needed for all phases of the prescribed fire 
until the fire is declared out. 

 (USDA and U.S. DOI, 2008, pp. 23-24) 

Public and Personnel Safety, Medical 

Describe provisions to be made for public and 
personnel safety.  Identify and analyze the 
safety hazards unique to the individual 
prescribed fire project and specify personnel 
safety and emergency procedures. 

Identify and analyze the safety hazards 
unique to the individual prescribed fire 
project and specify personnel safety and 
emergency procedures. 

Communication 

Develop a communications plan specific 
to the project's implementation to 
address safety and tactical resource 
management needs. 
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Test Fire and Ignition Plan 
(Elements 14 and 15) 

Test Fire 

Provisions for a test fire are required and 
results must be recorded.  The test fire must 
be ignited in a representative location and in 
an area that can be easily controlled. 

The purpose of the test  fire is to verify that 
the prescribed fire behavior characteristics will 
meet management objectives, and to 
verify predicted smoke dispersion. 

 (USDA and U.S. DOI, 2008, p. 24) 

Ignition Plan 

Describe planned ignition operations. 

Maps showing proposed firing patterns may be 
included. 

Multiple prescriptions and ignition operations 
may require identifying and developing multiple 
ignition organizations. 
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Holding and Contingency Plans 
(Elements 16 and 17) 

Holding and contingency plans must be developed with the consideration of 
the predicted fire behavior outside the project boundary(s). 

Holding Plan:  describes general procedures to be used for operations to 
maintain the fire within the project area and meet the project objectives until 
the fire is declared out (USDA and U.S. DOI, 2008, p. 24). 

Contingency Plan:  considers the possible but unlikely events and the actions 
needed to mitigate those events (USDA and U.S. DOI, 2008, p. 25). 

Fire behavior characteristics for fuel models within the maximum spotting 
distance and/or adjacent to the project boundaries must be considered and 
modeled. 

These predictions must be modeled using the 

 Hottest, driest, windiest prescription limits 

 Most extreme environmental conditions (slope, aspect) 

(USDA and U.S. DOI, 2008, p. 22) 
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Wildfire Conversion and Smoke Management and Air Quality 
(Elements 18 and 19) 

Wildfire Conversion 

A prescribed fire must be declared a wildfire 
by those identified in the burn plan when 
that person(s) determines that the 
contingency actions have failed or are likely 
to fail and cannot be mitigated by the end of 
the next burning period. 

Describe the actions to be taken when a 
prescribed fire is declared a wildfire.  This 
description is to include   

 Wildfire declaration 

 IC assignment 

 Notifications   

 (USDA and U.S. DOI, 2008, pp. 25-26) 

Smoke Management and Air Quality 

Described how the project will comply with 
local community, county, state, tribal, and 
federal air quality regulations. 

Identify what permits, if any, need to be 
obtained. 

Identify smoke-sensitive sensors (population 
centers, recreation areas, hospitals, airports, 
schools, etc.). 

Include modeling outputs and mitigation 
strategies and techniques to reduce the 
impacts of smoke production. 

Tip:  For more information on 
smoke management, visit the 
National Interagency Fire Center 
website. 

http://www.nifc.gov/smoke/
http://www.nifc.gov/smoke/
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Monitoring and Post-burn Activity 
(Elements 20 and 21) 

Monitoring 

Describe the monitoring that will be required 
to ensure that Prescribed Fire Plan objectives 
are met. 

For the prescribed fire, at a minimum, specify 
the weather (forecast and observed), fire 
behavior and fuels information, and smoke 
dispersal monitoring required during all 
phases of the project and the procedures for 
acquiring this information (including who and 
when). 

 (USDA and U.S. DOI, 2008, pp. 25-26) 

Post-burn Activity 

Describe the post-burn activities that must be 
completed. 

These activities include 

 The post-burn report 

 Safety mitigation measures 

 Rehabilitation needs 
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Appendices 

The following Appendices are 
created once the Burn Plan is 
generated and exported into a 
Microsoft Word document: 

A. Maps 

B. Technical review checklist 

C. Complexity analysis 

D. Agency-specific job hazard 
analysis 

E. Fire behavior modeling 
documentation and/or empirical 
documentation 

 (USDA and U.S. DOI, 2008, p. 27) 
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Generating the Burn Plan  

At the bottom of any Burn Plan page, choose Generate Burn Plan, then open the 
document with Microsoft Word. 

http://iftdss.sonomatech.com 
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Customizing the Burn Plan  

After downloading the burn plan into 
a Microsoft Word document, you can 
easily customize the burn plan.   

You can fill out Elements in the online 
burn plan template located within the 
IFTDSS website, and/or after 
generating the burn plan into a Word 
document.  

Click here for an example of a 
generated and customized Red Bull 
burn plan. 

Online burn plan template  

Note:  The online burn plan template has 
a 6,000-character limit per text box.  If you 
need more characters, generate the burn 
plan into a Word document (which has no 
character limit), and continue editing.   

Generated Word Document 

Burn Plan Template in IFTDSS 

Red_Bull_Generated_Plan.pdf
Red_Bull_Generated_Plan.pdf
Red_Bull_Generated_Plan.pdf
Red_Bull_Generated_Plan.pdf
Red_Bull_Generated_Plan.pdf
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Maps 
(Appendix A – Maps) 

Map Requirements 

At a minimum, the plan will include a vicinity and 
project map. 

The number of maps, map size and scale, legend, 
and level of detail should be appropriate for the 
complexity of the project. 

All maps will include the following standard map 
elements 

 Title 

 Name of Preparer(s) 

 Date 

 North Arrow 

 Scale 

 Legend 

 

(USDA and U.S. DOI, 2008, p. 21) 

Vicinity Map 

Map scale will be such that the burn units can 
be located on the ground and in sufficient 
detail to guide implementation. 

Project Map 

Identifies features in sufficient detail to guide 
and assist in operational implementation of 
the prescribed fire. 

Note:  in the generated burn plan, maps are 
located in Appendix A.   

The process of how to save a map image to 
your local computer and how to edit a map in 
the generated Burn Plan are discussed in the 
following pages. 
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The following pages show how to 

 Open Data Studio to view your 
Project Area. 

 Save a map image to your local 
computer. 

 Paste a map into the generated 
burn plan in Microsoft Word. 

 Edit a Vicinity Map in Microsoft 
Word. 

Appendices  
(Appendix A – Maps) 

 

For step-by-step instructions on how 
to export maps to Google Earth for 
advanced editing, refer to the 
tutorial:  How to use Hazard Analysis 
tools in the IFTDSS for Prescribed Fire 
Planning. 

../05-Hazard-Analysis/HA_Tutorial_Rx_Planning.pdf
../05-Hazard-Analysis/HA_Tutorial_Rx_Planning.pdf
../05-Hazard-Analysis/HA_Tutorial_Rx_Planning.pdf
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Navigate back to your Red Bull 
Project Summary page.  To do 
so, you can either 

Click on the Red Bull link at the 
top left of the page, 

or 

Access the Projects tab and 
navigate to your project (in this 
example, Red Bull). 

Appendices  
(Appendix A – Maps) 

 . B 

A 

A 

B 
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Appendices  
(Appendix A – Maps) 

 At the bottom of the Project 
Summary page, under the 
Project Data section, select 
Edit. 

The Data Studio window 
appears. 

Note:  Pop-up blockers must be 
disabled in order to open Data 
Studio. 
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Save a Map Image 
(Appendix A – Maps) 

  
In Data Studio, you can save an image of your project area and the 
surrounding area for your Vicinity Map. 

In this example, we’ve 
selected the Street Map 
view. 

To save the map, choose 
Save Map Image         . 
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Save a Map Image to Your Local Computer 
(Appendix A – Maps) 

 

 
When you choose Save Map Image, you can open 
your image or save your image.   
 
In this example, we are going to  
save the image and then paste it  
into our generated burn plan  
document. 

http://iftdss.sonomatech.com 
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Navigate to the Vicinity Map in the Generated Burn Plan 
(Appendix A – Maps) 

 

 

Tip:  For easy navigation in Microsoft Word 2010, access the View tab and select Navigation Pane. 

Open your generated burn 
plan in Microsoft Word and 
navigate to 1. Vicinity Map. 
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Inserting a Saved Map Image into Word 
(Appendix A – Maps) 

 

 To insert a saved map image 
into a Microsoft Word 
document, 

Highlight the <Insert Map 
Here> text. 

Access the Insert tab and 
select Picture. 

Navigate to your saved 
map image and select 
Insert. 

 

1 

2 

3 

1 

3 

2 

1 

2 

3 
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Drawing the Burn Unit Onto the Map 
(Appendix A – Maps) 

 
1. Resize the image to fit on the 

Vicinity Map page. 

2. Right-click on the map, select 
Wrap Text, then select Behind 
Text.  

This makes it easier to move the 
map around on the page. 

3. Access the Insert tab and 
choose Shapes. 

4. Under Lines, select the 
Scribble option. 

5. Using the Scribble feature, 
draw an outline of your burn 
unit. 

Zooming in will help you accurately 
draw the burn unit. 
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Editing and Labeling the Burn Unit 
(Appendix A – Maps) 

 
1. Right-click on your burn unit and select 

Format Autoshape. 

2. Choose a red fill color and choose OK. 

3. Click on Shapes again and select a 
 callout shape. 

4. Use this shape to label your burn unit. 
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Appendices 
(Appendix B – Technical Reviewer Checklist) 

The technical reviewer 

 Ensures that prescribed burn plans meet 
policies. 

 Ensures that the complexity analysis 
accurately reflects the project(s). 

 Ensures that the prescription parameters 
meet the resource and control objectives. 

 Ensures that the ignition, holding, and 
contingency plans are consistent with the 
predicted fire behavior. 

 Completes and signs the Technical Reviewer 
Checklist and the Prescribed Burn Plan 
Signature Page. 
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Appendices 
(Appendix C – Complexity Analysis) 

The Complexity Analysis contains 14 
elements with three factors to consider for 
each element: 

• Factor 1 is Risk:  the probability an 
adverse event will occur. 

• Factor 2 is Potential 
Consequences:  the measure of 
cost/result of an adverse event. 

• Factor 3 is Technical Difficulty:  
the skill needed to implement the 
burn and deal with potential adverse 
events. 

Values are assigned for each of the factors:  
low, moderate, or high. 

Note:  Refer to the Prescribed Fire 
Complexity Rating System Guide for 
more details. 

Tip:  Back to Element 3 

http://www.nwcg.gov/pms/RxFire/complexity_analysis.pdf
http://www.nwcg.gov/pms/RxFire/complexity_analysis.pdf
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Appendices 
(Appendix D – Agency-Specific Job Hazard Analysis) 

A job hazard analysis is a technique 
that focuses on job tasks as a way 
to identify hazards before they 
occur. 

This analysis focuses on the 
relationship between the worker, 
the task, the tools, and the work 
environment. 

Ideally, after you identify 
uncontrolled hazards, you will take 
steps to eliminate or reduce those 
hazards to an acceptable risk level. 
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Appendices 
(Appendix E – Documentation) 

You can paste the exported 
Microsoft Excel table(s) (see page 
38) into the Word document in 
Appendix E. Fire Behavior 
Modeling Documentation or 
Empirical Evidence. 


